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This guide provides step-by-step instructions for integrating Webex with
Microsoft Outlook, enabling users to schedule Webex meetings directly
within Outlook. It also outlines the available options before and after
scheduling a meeting.

Step 1: Install the Webex Scheduler Add-In

1. Open Microsoft Outlook on your desktop or web browser.
2. Navigate to the File tab and click on Manage Add-ins.
o For Mac OS Users, while in Outlook go to Tools > Get Add-ins

Manage Add-ins
@} Manage and acquire Web Add-ins for Outlook.

Manage Add-

ins
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3.

In the Add-ins for Outlook window, search for "Webex Scheduler."

Add-Ins for Outlook

Add-ins may access personal information. By turning an add-in on, you agree to its License Terms and Privacy Policy.

Al
My add-ins

Admin-managed

@ Editor's Choice

P We recommend this great collection of add-ins for you to get started.

&7 Send feedback

X

| Webex Schedulerl

Q Cisco Webex Scheduler

Show all results

Priority Matrix: Turn m Tasks in a Box for 7  Revenue Grid for
emails into tasks Outlook 4‘ Salesforce CRM
ok kK VU xRk Rt 2]

Create and prioritize tasks from email.
Access contextually relevant items. Free
to use in Outlook.

Always stay on top of your inbox.
Snooze emails and tumn them into tasks.

#1 Salesforce integration solution that
actually works. Salesforce Inbox
alternative

Additional purchase may be required @ Additional purchase may be required Additional purchase may be required
Add Add Add
% Trustifi for Outlook — Leave Request for
T ’lm Secure and Productive Outlook
rustifi - s % Fok kKK

Get true email power with encryption,
controlling, tracking and certified email.

Additionl purchase may be required

Request, track, approve and manage
the requested. Easy to use, configured,
and very flexible

Additional purchase may be required

Add

4. Click on Add to install the Webex Scheduler add-in.

w Cisco Webex Scheduler

Cisco Webex | k¥ (100 | Additional purchase may be required

By clicking on add, you agree to the add-in's License terms and Privacy policy
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5. Verify the Webex Scheduler appears in the My add-ins menu

&7 Send feedback
Add-Ins for Outlook

Add-ins may access personal information. By turning an add-in on, you agree to its License Terms and Privacy Policy. O Search add-ins
Al My add-ins
My add-ins

Store Add-ins

Admin-managed

Add-ins that you added from the Office store

Cisco Webex Scheduler
w * kA

Schedule, start, and join Cisco Webex
meetings and Personal Room meetings.

Step 2: Connect Microsoft Outlook calendar to Webex

Prior to scheduling Webex meetings through Outlook, it is required that you connect your
Outlook Calendar to Webex.

Open Webex

Open the Settings menu

Navigate to the Meetings section

Under Calendar, choose the Connect Calendar button

PoOd=

Settings X

& General

Calendar

< Audio
Video
Sharing content
Notifications
& Appearance Connect a calendar
essibility
Schedule meetings
® Keyboard shortcuts
® Privacy
Phone Service
O Messaging

Meetings

Save Cancel
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5. Choose the Microsoft 365 calendar

Webex X

Choose a Calendar

Choose a calendar that matches

= Microsoft 365

Google Calendar

Cancel

6. Signinto your Outlook account with your credentials

Sign in to your account X

https://login.microsoftonline.com/common/oauth2/v2.0/authorize?scope=Cale

B® Microsoft
Sign in

Email, phone, or Skype

No account? Create one!

Can't access your account?

Qﬁ Sign-in options

7. Once the Outlook credentials have been entered, close the confirmation screen
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Webex

We're connecting you

It may take a few minutes to sync your data. Get ready to
see all your Microsoft meetings in Webex.

NOTE: Calendar synchronization may take up to 60-90 minutes to complete.

8. Once the Microsoft Outlook sync has completed, the Webex Scheduler icon will
appear in your Outlook toolbar. The “Add Webex Meeting” icons will only be
visible in the New Meeting window and not in the normal Calendar tab in

Outlook

- =i

File  Meeting ~Scheduling Assistant  Insert  FormatText Review Help

. A Y [ = I Private s
W 5] Calendar @ 75 [N @ ™ A‘J Eshowas [ susy : ”EJ 51 Prives 0} L_{
= o o High Importance
Delete oo . Skype Teams  Sendto Check Response (Y pvivier (15 minutes | Recumence | Cate Dictate Al New Viva
Meeting OneNote tions il aariancs Apps Scheduling Poll Insights
Adtions Skype Meeting Teams Mecting  Onellote Options Tags Voice  Apps Find Time Addin My Templates

equired
Opti

=) e0am v [alds

3| 100aM ] O MakeRecuriing
Location
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Step 3: Provisioning Webex Scheduler in Outlook

1. Open Outlook/Calendar and select New Meeting in top toolbar

= File Home Send /Receive Folder View Help

Q& ©® =& [@FE OEEE E

Add Focus  New New Skype Meet  Teams Today Next Day | Work | Week Month Schedule
Time  ltems~ Meeting Now Meeting v 7 Days Week View

Skype Meeting Teams Meeting GoTo N Arrange N

2. Click onthe Webex Preferences icon in the Outlook Calendar/New Meeting
window toolbar

W O

Add Webex  Webex
Meeting Preferences

Cisco Webex

3. Theinitial pop-up screen will allow you to set Webex as the default meeting
selection for all new meeting invites if desired. This can be cancelled and set
through the Outlook settings at a later date.

Manage Online Meetings X

/ If you want Cisco Webex Scheduler added to every meeting instead of Teams, you can update this in your Microsoft Outlook settings.

Open Settings ‘ Cancel
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4. Select Get Started to proceed to the Webex credentials screens

ddin/alli

Cisco Webex Scheduler - https://!

pi.webex.c /functions/signin/app.html?p fromFunction&spli X

Welcome

The Cisco Webex Scheduler helps you schedule and update Webex meetings easily in Microsoft 365.

* Schedule Webex meetings easily.
* See your upcoming meetings updated in your calendar.

* Work in any Microsoft Outlook app.

Sign up

5. Enteryour Webex site URL.

Cisco Webex Scheduler - http ings-api. in/alli ions/signi i it=... X

Which Webex site do you want to use?

@ Enter your Webex site URL:

Next

Version 45.2.0 © 2021 Cisco and/or its affiliates. Help
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a) The specific URL required for this step can be found under the
Settings/Meetings section in Webex.

Click the Settings icon in the left menu in Webexﬂ
Navigate to the Meetings section
Scroll down to the “Default Webex site URL” section
Capture the xxx.webex.com information
1. NOTE: https:// (https:// xxx.webex.com) must be added to
the front of the address when copied in the login window

PoOd=

Settings X

General 5
Schedule meetings

Audio Which scheduler do you want to use for scheduling meetings?

Video © Webex scheduler

Microsoft Outlook €@
Sharing content

Notifications
Step away from meeting
Appearance

Automatically set status to stepped away
% Accessibility
Keyboard shortcuts

Privacy

i Phone Service Default Webex site URL

: he following default Webex site for starting and
O Messaging

Meetings
Calling

Devices My Personal Room

Save Cancel
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6. Connectyour account. Select Continue

Cisco Webex Scheduler - http:

Connect your account

Your Microsoft Office 365 account is not connected to an account on this Webex site. If
you want to sign in to this Webex site with your Microsoft Office 365 account, you must
first sign in to Webex to connect your Microsoft Office 365 account with your Webex
account.

Coneel

© 2025 Cisco and/or its affiliates. All rights reserved.
Privacy Statement | Terms of Service

7. Enterthe email address that is associated with your Webex account

e
Cisco Webex Scheduler - https://idbroker.webex.com/idb/saml2/jsp/doSSO.jsp X

Welcome to Webex

Email address

Need help signing in? (2

\Mebex by €Isco By using Webex you accept the Notices & Disclaimers.
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8. Re-enter your Webex email address.

£
Cisco Webex Scheduler - http ingidp=https:%2F% idp-proxy-awebex.com%2Fapi%2Fv1&.. X

You are being redirected to sign into an external website. Please enter your
email address again for authentication

[ ]

9. Enterthe password associated with your Webex account.

Cisco Webex Scheduler - https://bwks-uap.webex.com/login?idp=https:%2F%2Fbroadworks-idp-proxy-a.webex.com%2Fapi%2Fv1 X

Enter your password

Password

Need help signing in? Reset your password
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10. Webex Scheduler provisioning is complete

\\

You've signed in to Webex
You can close this web page now.

Step 4: Webex Meeting Preferences prior to scheduling a meeting

1. Open Outlook and create a new meeting invite.

= File Home Send /Receive Folder View Help
Q & m % [CFE OEE EE
Y ™ Bl (][] =]
k=] Add Focus  New New Skype Meet  Teams Today Next Day | Work | Week Month Schedule
Time  ltems~ Meeting Now Meeting v 7 Days Week View
RQ\ Skype Meeting Teams Meeting GoTo N Arrange N
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2. Inthe event window, click on the Webex Preferences button (located in the
toolbar).

W O

Add Webex  Webex
Meeting Preferences

Cisco Webex

3. The Cisco Webex Scheduler menu will load on the right side of the screen

Cisco Webex Scheduler %

Joe Smith
bci-568.webex.com

Change Webex site | Sign out

Default meeting type

@® Generate a one-time meeting link

O Use my Personal Room link

ebex.com/meet/cschuette

Default Webex Meeting template

Webex Meetings Default v

4. Choose between the two default meeting types:
o Generate a one-time meeting link:

e Creates a unigue Webex meeting URL specifically for the scheduled
event.

o Ideal for meetings requiring higher security, as the link and associated
details are not reusable.

o |ncludes customizable options like passwords, waiting rooms, and
unique participant access settings.
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e Best for one-off meetings with people outside your organization or
requiring a formal setup.
o Default Webex Meeting template
e Left at default selection

Default meeting type

® Generate a one-time meeting link
O Use my Personal Room link

Default Webex Meeting template

Webex Meetings Default v

o Use myPersonal Room link:

e Utilizes a permanent, reusable link to your Webex Personal Room.

e Convenient for recurring or informal meetings with familiar
participants.

e Faster setup since the link doesn’t change, but it may have fewer
security features than one-time links.

e Bestforteam check-ins, quick discussions, or regular collaborations
with the same group.
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Default meeting type

O Generate a one-time meeting link

® Use my Personal Room link

Webex Personal Room meeting

Chris Schuette's Personal Room
bci-568.webex.com/meet/cschuette 0
cschuette@bci-568.webex.com

©
0263

Step 5: How to Add a Webex Meeting to an Outlook Invite

1. In Outlook, go to your calendar and click New Meeting to create a meeting invite.
2. Fillin the basic meeting details, such as:
o Title: Enter a descriptive title for your meeting.
o Attendees: Add participant email addresses in the Required/Optional
fields.
o Date and Time: Set the date, start time, and end time for your meeting.
o Location: Webex link will be automatically copied into the invite
3. Add Webex Meeting Details
o Inthe meeting invite window, locate the Webex Scheduler toolbar and click
on Add Webex Meeting.
o This action automatically inserts the Webex meeting link, dial-in information,
and other details into the meeting invite.
4. Customize Webex Meeting Preferences
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Cisco Webex Scheduler

Webex meeting

Meeting template

Webex Meetings Default v

Meeting type

Webex Meetings Broadworks Premium -

Password

sG8fNHWwx25

() Don't include meeting password in email
invitation ©

Cohosts

O The first person to join the meeting who
has a host account on this site becomes a
cohost

O All attendees who have host accounts on
this site become cohosts when they join
the meeting

® Let me choose cohosts for this meeting. ©

o After adding the Webex meeting to your invite, you can click the Webex
Preferences icon to tailor the meeting to your needs:
e Meeting Template: Left at default selection

e Meeting Type: Defaulted to Webex package assigned to your line

e Password: Designate a password for attendees to utilize if required to
join the meeting.

e Don'tinclude meeting password in email invitation

1. Ifthis option is checked, invitees won’t see the meeting
password in their email invitation, and when they click the join
meeting link, the password won’t be automatically entered for
them. Users will need to enter the password to join the
meeting, so you’ll need to send it to them in a separate
message

e Cohosts - Choose between:
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1. Thefirst person to join the meeting who has a host account on
this site becomes a cohost

2. All attendees who have host accounts on this site become
cohosts when they join the meeting

3. Let me choose cohosts for this meeting

e Advanced Settings

Advanced settings v

Host Information

Host key : 365694

Join before host @
Attendees can join |5 « | minutes before

start time

Audio connection type

Webex Audio v

Display global call-in numbers to attendees

Mute on entry

[)Mute attendees when they join

Entry and exit tone

Beep -

Breakout sessions

[JEnable breakout sessions

e Join before host — enable and choose minute amount attendees can
join before the meeting start time

e Audio Connection Type —select Webex Audio or Use VolP Only

e Display global call-in numbers to attendees — enable/disable

e Mute on Entry — mute attendees when they join

e Entry and Exit Tone - enable/disable beep
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o Breakout Sessions —enable breakout sessions

5. Finalize and Send the Invite
o Review the meeting invite to ensure all details are accurate.
o Add any additional information or instructions for attendees in the body of
the invite.
o Click Send to distribute the meeting invite to all participants.

Step 6: Updating the Default Meeting Provider for New Invites

This option will allow you to choose whether you want an online meeting automatically added to
every new invite created and what provider you prefer.

1. Open Outlook and navigate to the File tab/Options menu

2. Inthe Options menu, select the Calendar section

3. Under Calendar Options, the first checkbox allows you to automatically add online
meetings to all new invites and choose the default provider

4. Click the Meeting Providers button

Outlook Options ? X

-

y 4

[ Cancel

o ) - y
it @ Change the settings for calendars, meetings, and time zones.

l» Calendar ) Work hours and location
roups

F@) Set up your weekly schedule to let colleagues know when you're available and Work hours and location...

People in the office.

T First day of week: | Sunday ~|

Search First week of year: | StartsonJan1 v |

Language Calendar options

Accessibility @,‘Add online meeting to all meetings| ’ Meeting Providers... ‘ !
Advanced Default duration for new appointments and meetings: | 30 minutes ~ |

G iees [_J Shorten appointments and meetings:

Less than one hour:

Quick Access Toolbar
One hour or longer:
Add-ins Default reminders: | 15 minutes ~
Trust Center Allow attendees to propose new times for meetings

Use this response when proposing a new meeting time: [ '7 Tentative ~ [

Add holidays to the Calendar: ‘ Add Holidays... |

Change the permissions for viewing Free/Busy information: | Free/Busy Options... ‘ [ Other Free/Busy...

[C] Enable an alternate calendar

When sending meeting requests outside of your organization, use the iCalendar format

[Z] Show bell icon on the calendar for appointments and meetings with reminders

Display options
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5. Choose the default provider from the list between Microsoft Teams and Cisco Webex
Scheduler.

Online Meeting X

Apply to this account: F@ CSchuette@trusttelesystem.com|ig

Choose your default provider:
(® Microsoft Teams
(O Cisco Webex Scheduler

6. Once a new meeting invite is created, a link for the default provider selected will
automatically be added to the body of the invite.
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